4.0 FEMIS PC Installation

The following sections describe the steps needed to install FEMIS on a PC.

4.1 Installing the PC COTS

The order for installing the COTS on anew FEMIS PC is as follows:
1. Windows NT Workstation v4.0 and Windows NT Service Pack 5
2. Hummingbird NFS Maestro v6.2 and v6.2.0.2 patch or Solstice NFS Client v3.2
3. Oracle Net8 Client v8.1.5 and ODBC Driver v8.1.5.5
4. ArcView GISv3.1 and v3.1.1 patch
5. Microsoft Project 98 Service Release 1
Installing the following COTS products is optional .

E-mail application (if applicable)

Word processor (if applicable)

Spreadsheet (if applicable)

Graphics presentation  (if applicable).

At the end of this section, PNNL has provided two checklists that can be used for each PC installation.

e FEMIS PC Installation Checklist
« FEMISPC Validation Checklist.

Note: If you have aprevious version of FEMIS installed, verify that your COTS software
packages are the same version asthose listed in the FEMI S Bill of Materials (BOM). If

they are the same, proceed to Section 4.3, Installing the FEMIS Client Software, to install
the FEMIS application.

4.1.1 Installing Windows NT v4.0

4.1.1.1 Before Installing Windows NT

Issues you should consider before beginning the Windows NT installation include hardware requirements,
multi-boot capabilities, instalation tips, and storage device detection.



Federal Emergency Management FEMIS Installation Guide
Information Systems (FEMIS) May 26, 2000-Version 1.4.7

Hardware Requirements

There are two sets of information, which you must consider regarding hardware requirements for
Windows NT. First, you must check the Windows NT Hardware Compatibility List (HCL) published by
Microsoft. This document covers every type and model of hardware that has been tested for compatibility
with Windows NT. Thelist isupdated regularly and can be accessed at Microsoft’s Web site
(http://www.microsoft.com/hwtest/hcl/default.ntm). Check the HCL to verify that every major
component of your computer system is compatible with Windows NT. If one or more components are
not listed, contact Microsoft or the hardware vendor to see if new drivers or compatibility aids are
available. If not, you should think twice before installing Windows NT on your computer.

The second requirement that must be considered is minimum hardware requirements, which can be found
in the FEMI S Bill of Materials (BOM). If your computer does not meet these minimum
requirements, it is unlikely that Windows NT will work acceptably on this system.

Multi-Boot

Windows NT can coexist with other operating systems, including MS-DOS, Windows for Workgroups,
and Windows 95/98. The Windows NT installation program can detect these operating systems and
include them on the Windows NT bootup menu. However, MS-DOS and 16-bit Windows are only
supported if they were installed first, before Windows NT. Installing them afterward is strongly
discouraged by Microsoft and can cause unreliable Windows NT operation.

Windows NT Installation Tips

Installing Windows NT can be avery intimidating experience. There are many points where the operator
must make a choice, but very little information is available about how to choose or the potential
consequences of achoice. Fortunately, this problemis not insurmountable. If you plan ahead and collect
the necessary information before you begin, the installation processis much easier. Be sureto select
Custom installation.

After you select Custom installation for Windows NT v4.0, you will be given the following installation
options:

e Set Up Only Components Y ou Select

»  Set Up Network

* SetUpLoca Printer

»  Set Up Applications on the Hard Disk

»  Gathering information about your computer
e Installing NT networking

* Finishing Setup.

For modular installation, enable the Set Up Only Components You Select and Set Up Network options
and disable the others so you will be ableto install printer support and set up applications later.
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Storage Device Detection

During the Hardware Setup phase, the Windows NT installation program displays a list of mass storage
devices found on your computer. Thislist includes SCSI adapters and CD drive devices but does not
include IDE components. Do not worry--I DE devices are indeed recognized and will be supported by the
installation.

Gathering Configuration Information
Prior to installation obtain the following information from your System Administrator:

*  Computer name (for each machine)

» IPaddress (for each machine)

*  Subnet mask

» Default Gateway

*  Workgroup

* Domain

* DNS (Domain Name System) service search order
*  WINSservers, if applicable

* FEMIS server name

* FEMIS server IP address.

If thisinformation is unavailable from the System Administrator, it can be determined by using the steps
below to check a previously installed machine—provided one is available. It isimportant that you have
thisinformation prior to installation. Thisinformation allows you to setup your NT Networking.

4.1.1.2 Running the Installation Program

Note: Beforeyou install Windows NT from the FEMIS COTS CD, read Section 4.1.1.1, Before
Installing Windows NT.

Y ou will need to know the 10-digit CD Key number to enter during the Windows NT
installation. The CD Key number islocated on your licensed Windows NT installation
disk.

The CD driveisusualy your D:\ drive and will be referred to as the D:\ drive in the
following instructions.

Y ou will need to create aformatted DOS partition within the first 2GB of the primary

disk on the system you areinstalling. Use tp DOS boot floppy and use the fdisk utility to
create the partition. Use the format command to format the drive.
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1. Placethe FEMIS COTSCD into the CD drive, and enter \I386\WINNT /B at the C:\ prompt.

Note: Besuretoinclude/B or you will be prompted to insert three formatted disks.

2. At theD:\ prompt, enter \I386, and the Windows NT Setup window will be displayed. Please wait
while Setup copies filesto your hard drive.

3. Restart the computer and continue with the Windows NT Setup.

4. PressEnter to continue setting up WINNT per the Welcome window that displays.

5. PressEnter to continue installation. Windows NT Setup displays alist of mass storage devices found
on the computer. Thislist includes SCSI adapters and CD drive devices but does not include IDE
components. The <SCSI Adapter> and <CD drive devices> will display. Thisindicates that Setup
has recognized mass storage devices in the computer.

6. Page down and select F8 to agree when the Windows NT Licensing Agreement window displays.

7. PressEnter to continue when the Windows NT Setup displays the computer’ s hardware and software
components.

8. Install Windows NT on the desired partition
9. Setup will install Windows NT on the partition. Leave the current file system intact (no changes).

10. Setup will install WINNT files on the hard disk. Choose the location where you want these filesto be
installed, a common location is\WINNT.

11. Setup can aso examine the hard disks for corruption.

* Toalow Setup to perform an exhaustive secondary examination, press Enter.
* Toskip this step, pressthe Esc key.

Though thisis not necessary and takes several minutes, we recommend you compl ete this step.
12. Restart the computer once this portion of the Setup has completed successfully.
The Windows NT Setup is gathering information about the computer. Advanced users can customize
all available setup options. Y ou will be prompted regarding the next three parts of the Setup:
1) Gathering Info, 2) Installing Windows NT Networking, and 3) Finish Setup.

Part One of Setup—Gathering Info

13. Select 1. Gathering Info, and click Next. On the Setup Options window, select Custom, and
click Next.
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14.

15.

16.

17.

18.

19.

20.

Enter the name and organi zation associated with the computer. Click Next.

Enter the 10 digit, CD Key. The Windows NT registration number islocated on the back of the
Windows NT CD cover.

Enter the computer name.

Enter the Administrator password for the Windows NT Administrator account. Repeat this step to
confirm the password.

It is recommended that you create an Emergency Repair disks for each computer on which Windows
NT v4.0 isbeing installed.

» Select Yes to create an Emergency Repair disk
» Select No if you do not want to create an Emergency Repair disk.

Click Next.

Click Next to accept the default list of components on the Select Components window that displays.

Part Two of Setup—Installing Windows NT Networking

21.

22

23.

24,

25.

26.

Select 2. Installing NT Networking. Click Next.
Click Next accept the defaults: This computer will participate on a network and Wired to the network.

Select Start Search to allow Setup to locate the default network adapter. Once the default network
adapter has been located click Next.

Select TCP/IP Protocol for the networking protocols that are used on your network. Thisisthe
protocol used to connect to the Internet and Wide Area Networks (WANS). Check with your System
Administrator to seeif any additional protocols should be selected. Click Next.

Click Next to accept the default—All Network Services. Install the selected components

* RPC Configuration
* NETBIOS Interface

*  Workstation
e Server
Click Next.

Check with your System Administrator about special settings that may be required for the network
adapter card and in addition to host name resolution. If there are none, accept the default values
associated. Click Continue.
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27. Select use Network Parameters, even if they cannot be verified.
28. Click No to use DHCP on the TCP/IP Setup Window that displays.

29. Enter the IP Address, Subnet Mask, and Default Gateway val ues specified by your System
Administrator.

30. Check with your System Administrator to seeif the domainis required for Domain Name System
(DNS). Select the DNS tab, and enter the domain, if required. The Hostname will have been entered
by default when the computer was named. If necessary, select Add DNS Search Order.

31. Select Add Primary and Secondary WINS Servers, if required, for the Windows Internet Name
Services (WINS).

32. Accept the default—Enable LMHOSTS Lookup. Check with your System Administrator to seeif this
isrequired.

33. Enable DNSlookups, if required. Check with you System Administrator regarding DNS setup
configuration.

34. Check with your System Administrator to seeif Routing isrequired. Click the Routing tab, and
enable the IP forwarding. Click Apply and OK.

35. Accept the defaulted network components that will communicate using this protocol. Check with
your System Administrator to see which items should be selected. The Show Bindings window will

display.

» Click Next to accept the default—All Services.
* Click Next again to start the network.

36. Select Workgroup, and enter the value.
Part Three of Setup—Finish Setup
37. Select 3. Finishing Setup. Click Finish.

38. Select the appropriate Time Zone, and check Automatically adjust clock for daylight savings time on
the Date and Time Properties window that displays. Click Close.

39. Accept the default if the system found a video adapter for the computer. Click OK.
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40. Select Test to preview settings from the Display Properties window that displays. The GIS operates
optimally with a Color palette set to 65536 colors.

The new mode will betested. Click OK and wait 5 seconds to determine whether it works properly.
Click Yes and OK.

41. Restart the computer for Windows NT to setup and save the previous choices. Select Windows NT4.0
as your operating system. Press Enter.

4.1.1.3 Installing Windows NT Service Pack 5

Service Pack 5 was the current Service Pack issued by Microsoft and was used during the devel opment
and testing of FEMIS 1.4.7. It isrecommended this service pack be installed to ensure compatibility.

Toingtal Windows NT Service Pack 5, insert the FEMIS COTS CD into the CD drive, and complete the
following steps:

1. Logininto Windows NT as a user with Administrator privileges.
2. Close any open applications.

3. Click Start » Programs - Windows NT Explorer = D:\NT4SP5\UPDATE. Double-click
UPDATE.EXE to run the Update program.

4. Check Accept the Software License Agreement checkbox.

5. Check the other checkbox to backup your current filesto uninstall the Service Pack at alater time.
This requires more disk space.

6. Click Install to install the Service Pack.

7. Click Restart to restart the computer.
4.1.2 Installing an NFS System
For FEMISv1.4.7, you may install either NFS Maestro v6.2 and v6.2.0.2 patch or Solstice NFS

Client v3.2 for your NFS System. If you will be using Samba to map server drives on the PC, then no
NFS software needs to be installed on the PC.

CAUTION

Do not install an NFS system until after you have completely installed Windows NT, including
the network setup.
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Note: If NFSMaestro v6.0.1 or earlier was previoudly installed on the PC, it must be removed
before you install NFS Maestro v6.2 and v6.2.0.2 patch or Solstice NFS Client v3.2.

Versions of Maestro 6.1 or later can be upgraded.
If you have Maestro v6.2 installed, you only need to install the NFS Maestro v6.2.0.2 patch.
4.1.2.1 Identifying the Maestro Version

To know if you will need to upgrade to NFS Maestro v6.2 or only install the v6.2.0.2 patch, complete the
following steps.

1. Goto %WINDIR%\SYSTEM32\DRIVERS.

2. Right click on HCLNFS.SYS.

3. Select Properties.

4. Check the version of thefile in the Version tab.

Another way to verify if you currently have NFS Maestro v6.2, or later, isto aseeif the HCRPCLIB.DLL
filein located in %WINDIR%\SYSTEM32 directory. Itisanew file with NFS Maestro v6.2.

4.1.2.2 Uninstalling NFS Maestro v6.0.1 (or earlier)

Complete the following steps to remove NFS Maestro v6.0.1 (or earlier). If NFS Maestro has not been
installed on the PC, skip this section.

1. Loginto Windows NT as auser with Administrator privileges.
1. Click Start > Programs = NFS Maestro = Uninstall.

2. Click Yes onthe NFS Maestro Client — Uninstall window. The default radio button is set to Remove
completely from Systems for all Users.

3. Click Yes when prompted to remove the registry entries, program groups, and installation directory.
4. Click Yes “I Agree” on the License Agreement window.

5. Click Yes to restart the computer.

4.1.2.3 Installing NFS Maestro v6.2

Toinstall or upgrade to NFS Maestro v6.2, insert the FEMIS COTS CD into the CD drive, and complete
the following steps.
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1. Logininto Windows NT as Administrator.
2. Click Start > Run = Browse > D:\MSTRO62\SETUP.EXE. Click Open and OK to run the
SETUP.EXE program.
3. Select the language you want to use. English isthe default. Click OK.
4. Click Next on the Welcome Window.
5. Click Yes on the License Agreement window.
6. Select Custom for installation type. Click Next.
7. Click Yes to Allow All Users of this Machine to See this Installation. Click Next.
8. Specify the Maestro Home directory. Click Next to accept the default C\APROGRAM

FILES\MAESTRO.NT.

9. Specify the Maestro User directory. Click Next to accept the default C:\PROGRAM

FILES\MAESTRO.NT\USER.

10. Deselect the Jconfig daemon (Java component) from the list of itemsto ingtall by clicking on it.

Click Next and Finish.

Note: The Jconfig daemon requires Microsoft Java Virtual Machine, which is generally not
installed on FEMIS PCs. FEMIS does not require this software or daemon to be
installed.

11. Click the Skip on the Site Information window.

12. Click Finished on the Site Information window.

13. Click Next or Skip when prompted to create a shortcut on your desktop-thisis optional.

14. Click OK in the Scan for NFS Servers window.

15. Verify the following are in the NFS Magestro Client for Windows NT — Configuration window:
General Tab

1. Enter the name of your FEMIS server in the Default Authentication Server field.

2. Check TCP and DOS-style sharing under Default Links.
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3. Under Default Protection for User and Group check R W X (Read, Write, and Execute).

Note: If this PCisrunning the EMIS client, be sure the Filename Capitalization is set to
Lowercase.

Read/Write Settings Tab
1. Increasethe Default Read and Write Sizes to the maximum — 65536.
2. Click Close.

If you get a message about important user files that differ from previousfiles, click OK, and ignore
the message.

3. Click No when prompted to have setup close all applications and restart the computer.
Y ou are now ready to install the NFS Maestro v6.2.0.2 patch.

4.1.2.4 Installing NFS Maestro v6.2.0.2 Patch

Complete the following stepsto install the Maestro v6.2.0.2 Patch.

1. Loginto Windows NT asauser with Administrator privileges.

2. Click Start » Run > Browse - D:\NFSPATCH\NFS6202_NTI.EXE. Click Open and OK to run this
program.

3. Click Continue in Patch Installer window.

4. Click Next in Welcome window.

5. Click Yes in Software License Agreement window.
6. Click Next in Start Copying Files window.

7. Leave Yes selected to have Setup shutdown and restart computer or select No and manually restart
the computer after the installation.

8. Click Finish.
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4.1.2.5 Running the Parmset Configuration Program

The Parmset Configuration program will run automatically when you log onto the PC after the installation
of NFS Maestro 6.2. This program can be rerun anytime by using Start > Programs > NFS Maestro >
Parmset. The system has to have been rebooted since the Maestro installation for the Parmset
Configuration program to work correctly.

1. Select Continue and run the Parmset Configuration program after setting the following parameters:

Remote Host: <servername>
FileSystem: <serverpath>
UserName: <femis>
Password: <password>

Select TCP.
2. Click OK.

This program takes from 10 to 15 minutesto run. Accept the best transfer rate. The PC will need to be
rebooted for the changes to work correctly.

4.1.2.6 Installing Solstice NFS Client v3.2

For an upgrade or new installation of Solstice NFS Client v3.2 on a PC, insert the FEMIS COTS CD into
the CD drive, and complete the following steps:

1. Logininto Windows NT as Administrator.

2. Click Start » Run - Browse = D:\SOLSTICE\SUNWFILE.EXE. Click Open and OK to run this
program on the COTS CD.

3. Enter your Solstice NFS Client v3.2 serial number on the User Information window.
Note: If you are upgrading, your old serial number will display but might not work. If you
select Evaluation, your product will expirein 30 days, and FEMIS will not work
correctly.
Click Next.
4. Click Yes to continue on the Registration Confirmation window.
5. Accept the default installation directory on the Choose Destination Location window, and click Next.
If you are upgrading from Solstice NFS Client v3.1+, click OK for the setup to upgrade your current

installation.
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6. Select Typical installation on the Setup Type window that displays, and click Next.

7. Click Next to configure the software on the Setup Configuration Wizard window.

8. Click Next to accept the Windows Default Name Service.

9. Click Next to start copying files. If prompted, click Yes to overwrite read only files.

10. Select No, | will restart my computer later. Click Finish.

To properly configure Solstice, complete the steps in the following section, Configuring Solstice NFS
Client v3.2.

4.1.2.7 Configuring Solstice NFS Client v3.2
To configure Solstice NFS Client v3.2, complete the following steps:
1. Click Start & Settings - Control Panel - Network = Services tab.
If thisisanew installation, you will need to click Add, select the Solstice NFS Client, and click OK.
2. Select the Solstice NFS Client on the Servicestab, and click Properties.
3. Select the Security tab on the Solstice NFS Client Configuration window.

4, Select Read, Write, and Execute for the User and Group on the Default File Creation Permissions
section. For Other, only select Read and Execute.

5. Select the Use a Specific Authentication Server, and enter your EOC’s server. Click OK and Close
the Network window.

Note: The server needsto be running the Solstice pcnfsd daemon. See Section 2.1.4.4,
Installing Sun PC NFS Daemon.

6. Click Yes to restart the computer now.

Note: When the computer restarts and islogged into the network, the Solstice NFS Client will
try to validate the user name and password on the authentication server that was entered
in Step 6. If the user does not have an account on this server or passwords on the PC and
server are not the same, you will be prompted for a user name and password for Solstice
NFS Client aswell asyour NT workstation login.
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4.1.3 Installing Oracle Net8 Client v8.1.5 and ODBC Driver v8.1.5.5

If aprevious version of Oracle SQL* Net and the ODBC driver have been installed, they should be
removed. If applications other than FEMIS are using your previous version of Oracle, check with the
vendor for information on compatibility.

Oracle can be setup on a PC using multiple versions of Oracle using separate directories and Oracle
homes, which is not discussed in this procedure.

Since this procedure calls for the removal of the ODBC driver, any DSN (data source name) using the
Oracle 7 driver, other than ones created by the FEMIS install, need to be deleted using the ODBC Data
Source Administrator located in the Control Panel. Y ou should document the parameters for these DSNs

so they can be recreated using the new Oracle ODBC driver. The FEMISinstall will automatically
change the DSNs for the site you are ingtalling.

4.1.3.1 Uninstalling Oracle SQL*Net Client v2.3.4 and Oracle7 ODBC Driver

If either FEMIS or Oracle has previoudly been installed on the PC, you will need to perform this section.
If aprevious version of Oracle has not been installed on the PC, skip this section.

1. LogintoWindows NT asauser with Administrator privileges.

2. Click Start » Programs - Oracle for Windows NT = Oracle Installer.
The Oracle Installer shows your Oracle Home directory where Products Installed at.

3. Save copies of your TNSNAMES.ORA and SQLNET.ORA located in the <Oracle
Home>\NETWORK\ADMIN directory. If you have other files you wish to keep in the Oracle Home

directory, save them a so.

4. Select all Oracle Productsinstalled that are listed in the right column of the Oracle Instaler. You
can hold the Shift key down and select the first and last product to select them all.

5. Click the Remove button in the center of the window.

6. Click Yes to confirm removal of products.

7. Click OK in Informationa window that the Oracle Installer will not be removed.

8. Click Exit to close the Oracle Installer.

9. Deletethe Oracle Home directory.

10. Delete the Oracle for Windows NT program directory. Using Windows NT Explorer, browse to

C:\WINNT\PROFILES\ALL USERS\START MENU\PROGRAMS. Locate the Oracle for Windows NT
directory and deleteit.
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11. Click Start > Run. Enter regedit in the Open field, and click OK.

12. Right mouse click on the ORACLE key and select Delete under
My Computer\HKEY_LOCAL_MACHINE\SOFTWARE.

Note: Be careful when editing the Windows NT registry. Modifying the wrong items can result
in adysfunctional system.

4.1.3.2 Installing Oracle Net8 Client v8.1.5

Toingtal Oracle Net8 Client v8.1.5, insert the FEMIS 147 COTS CD into the CD drive, and complete the
following steps.

1. Loginto Windows NT as auser with Administrator privileges.

2. Click Start » Run > Browse - D:\ORACLES815\SETUP.EXE. Click Open and OK to run this
program.

The Oracle Universd Installer will start.
Click Next in the Welcome window.
3. Accept the defaultsin the Destination Path in the File Locations window.

e Destination Name: ORAHOMES81
e Destination Path: C:\ORACLE\ORAS81

Note: The Destination Name and Path can vary due to previous Oracle installations.
Click Next.

4. Click Next to install Oracle8i Client v8.1.5 in the Available Products window.

5. Choose Custom in the Installation Typeswindow. Click Next.

6. Check the following boxesin the Available Products window:

* Net8 Products 8.1.5.0.0
 Net8 Client 8.1.5.0.0

* Oracle Installation Products
e Oracle Universal Installer 1.6.0.9.0
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10.

11.

12.

13.

14.

Uncheck the following boxes:

*  Oracle Utilities

* Oracle Configuration Assistant
» Development Tools

*  Oracle Java Products

Note: These are the minimum required productsfor FEMIS. If you need additional items, they
can be also installed, but they may require additional configuration during setup that is
not covered in this document.

Click Next.

Click Next in Component L ocations window.

Ensure only TCP/IP is selected in the Oracle Protocol Support window by holding down the Ctrl key
and clicking on items to select or deselect them. Click Next.

Click Install in the Summary window.

After Oracle products are installed, the Configuration Tools window will appear, and the Net8
Configuration Assistant will run.

Click Cancel in Net8 Configuration Assistant Welcome window.

Click OK in Error window that appears.

Click Next in the Configuration Tools window.

Click Exit in the End of Installation window, and Yes on the message box that appears.

Restore your TNSNAMES.ORA and SQLNET.ORA to ORACLE_HOME\NETWORK\ADMIN directory
if you are upgrading from a previous Oracle installation.

4.1.3.3 Installing Oracle ODBC Driver v8.1.5.5

Oracle Net8 Client v8.1.5 must be installed before you complete the following stepsto install the ODBC
Driver 8.1.5.5.

1

2.

Click Start-> Programs - Oracle Installation Products = Universal Installer.

Click Next in the Welcome window.
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3. Click Browse = <COTS drive letter>:\ODBC8155\PRODUCTS.JAR in the Source... Path: field.
Click Open. Click Next.

4. Click Yes in the Dependencies window that appears.
5. Click Install in the Summary window.

6. Click Exit in the End of Installation window, and Yes on the message box that appears.

4.1.4 Installing ArcView GIS v3.1 and v3.1.1 Patch

Note: If youreinstall ArcView GIS after having aready installed FEMIS, the correct version of
the file DEFAULT.APR will be overwritten by the ArcView GISinstalation. Copy the
DEFAULT.APR file from your C:\FEMIS directory to the
<DRIVE>\ESRNAV_GIS30\ARCVIEW\ETC directory on the PC. If you cannot find
C:\FEMIS\DEFAULT.APR, then the file may be copied from /home/femis/pc/femmisc/ on
your server.

ArcView GISv3.1 must be installed on the computer before you install the v3..1.1 patch,
and the patch must be installed for FEMIS to work properly.

If an older version of ArcView GISis currently on the PC, remove it before installing ArcView GISv3.1.
Note: If morethan oneversion of ArcView GISisinstaled on the PC, FEMIS will find the
most recently installed version. If you have multiple versions of ArcView GISinstalled,

check the %WINDIR%\FEMIS.INI file after the FEMIS instalation is complete to make
sure that the file references the correct install ation.

4.1.4.1 Installing ArcView GIS v3.1

Y ou will need to have the ArcView GIS license number for thisinstallation. The CD key number is
located on the ArcView GISinstallation disk.

To Install ArcView GISv3.1, insert the FEMIS COTS CD into the CD drive, and complete the following
steps:

1. Loginto Windows NT as Administrator.
2. Click Start > Run = Browse - D:\AV3.1\SETUP.EXE. Click Open and OK to run this program.
3. Click Next in the Welcome window.

4. Click Yes in the License Agreement window.
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5. Choose Local install for installation type. Click Next.

6. Select Custom and other options you may want to install. Click Next.

10.

10.

11.

12.

13.

14.

15.

Note: If you are upgrading, click Yes to replace current instalation.

If you are attempting to upgrade and you are not prompted to replace the current
installation, click Back and verify the install destination has ArcView installed.

Deselect the Map data and Launch Seagate Crystal Reports 6.0 setup. Click Next.

Note: Map dataand Seagate Crystal Reports are not used by FEMIS but can be ingtalled if
desired.

Click Next to accept the defaults for Program Folders and Existing Folders. The Start Copying Files
window displays.

Click Finish to start copying thefiles.

Click OK in the information window.

Click Yes and Finish on the Setup Complete window to restart the computer.

Re-logon to the computer using the same user account that was used to install ArcView.
Click Start » Programs = ESRI = ArcView GIS version 3.1 = ArcView GIS version 3.1.

Enter the name and organization and the ArcView GIS license number. Click OK, and ArcView GIS
will start.

Deselect the Show this window when ArcView GIS Starts box on the Welcome to ArcView GIS
window. Click Cancel.

Click File > Exit to close The ArcView GIS v3.1 application.

4.1.4.2 Installing ArcView GIS v3.1.1 Patch

Note: ArcView GISv3.1 must beinstalled before installing ArcView GISv3. 1.1 patch.

To Install ArcView GISv3.1.1 patch, insert the FEMIS COTS CD into the CD drive, and complete the
following steps:
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1. Loginto Windows NT as Administrator.

2. Click Start & Run = Browse = D:\AV3.1 PATCH\AV31PATCH.EXE. Double-click on theto run this
program.

3. Click Yes to continue the installation of ArcView GISv3.1.1 patch.
4. Click Next to accept the default Local Install.
5. Click Next to accept the default destination location.

6. Click Next in the Review Current Settings window that displays inside the Start Copying Files
window.

7. Click Finish and reboot the PC before using ArcView GISv3.1.
4.1.4.3 Creating the ArcView GIS Icon for All Users
The ArcView installation only installs the ESRI Program folder that contains the ArcView GIS 3.1 icons
for the user that installed the software. If you would like more than this user to run ArcView from
Program folders, you will need to copy the ESRI Program folder to the other users profile. FEMIS does
not require ArcView GISv3.1.1 bein Program folders. Y ou can copy the Program folder from the
installer’ s user profile to the All Users profile using the following procedure.
1. LogintoWindows NT asauser with Administrator privileges.
2. Click Start - Programs - Windows NT Explorer.

Note: You must use Windows NT Explorer to complete the following steps.
3. Browseto the %WINDIR%\PROFILES\<Installation user>\Start Menu\Programs.
4. Right click onthe ESRI folder and select Cut.

5. Browseto the %WINDIR%\PROFILES\AIl Users\Start Menu.

6. Right click on the Programs folder and select Paste.

4.1.5 Installing Microsoft Project 98 Service Release 1

If aprevious version of Microsoft Project has been installed, completely uninstall the previous version
before completing thisinstallation.
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Note: If the Microsoft Project 98 Service Release 1 installation was unsuccessful, it is because
the data access drivers on the PC have been corrupted. On the FEMIS COTS CD, usethe
mdac_typ.exe fileto replace the current data access drivers, and you should be able to
successfully install Microsoft Project. For more assistance call the IEM Help desk or
PNNL.

Y ou will need to have the Microsoft Project license number during the installation. The CD key number
islocated on your licensed Microsoft Project installation disk.

To instal Microsoft Project 98 Service Release 1, insert the FEMIS COTS CD into the CD drive, and
complete the following steps:

1. Logininto Windows NT as Administrator.

2. Click Start > Run > Browse - D :\msp98sr1\SETUP.EXE. Click Open and OK to run this program.
3. Select Continue on the Close Any Open Applications window.

4. Enter the name and organization information, if requested. Click OK.

5. Click OK to confirm the name and organization.

6. Enter the Microsoft Project CD key number.

7. Click OK to acknowledge the Product ID.

8. Accept the default destination folders.

9. Click Custom Install.

10. Click Data Access and Change Option. Select the Database Drivers Utility option, and click OK.
11. Click Continue to begin copying files.

12. Click OK when theinstallation is complete.

4.1.6 Installing Other COTS
The following COTS products should be installed using the installation documentation for each product.

E-mail application (if desired)
Use the standard product installation notes provided with the software.

Word processor (if desired)
Use the standard product installation notes provided with the software.
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Spreadsheet (if desired)
Use the standard product installation notes provided with the software.

Graphics Presentation (if desired)
Use the standard product installation notes provided with the software.

4.2 Configuring the FEMIS Setup Program

CAUTION

Configuration isonly done once at each EOC. Stop PC installation until all configuration
has been performed.

Several other files must be configured for your site or EOC. Most of these files should have been
configured during the FEMIS UNIX installation but should be validated before installing the FEMIS
application on the PCs.

Note: Directories specified below are from the PC. You will need to use the UNIX version of
these directoriesif you are editing files from the UNIX server.

4.2.1 Connecting the Network Install Drive

To connect the FEMIS network drive to the install directory, complete the following steps. The partsin
italics are what should be changed.

1. Obtain the shared name of the FEMIS account home directory from your from your System
Administrator. Example: Samba/Solstice — \\<server>\femis. Maestro — \\<server>\/disk#/femis.

2. Open the Windows NT Explorer.

3. Select Tools > Map Network Drive menu option, and fill in the fieldsin the Connect Network Drive
window asfollows.

Drive: I\

Path: \\<server >\femis

Connect as. femis

Enter <network password> when prompted.

The FEMIS network drive will be displayed in the All Folders pane on the left side of the Windows NT

Explorer window. Any available drive letter can be used in place of I:\ for the installation drive.
However, this documentation will assume that FEMIS is being installed from the I\ drive.

4-20



Federal Emergency Management FEMIS Installation Guide
Information Systems (FEMIS) May 26, 2000-Version 1.4.7

4.2.2 Validating the 'N\CONFIGD\FSETUP.INI File

The FEMIS Setup program uses a configuration file to determine the defaults for the installation.
Validate that the IN\CONFIGD\FSETUP.INI file was correctly configured during the server installation.

The first section of the INI file, the [Setup Defaults] section contains entries that set defaults for the Setup
program. Starred items (*) are those that should have been configured by the UNIX ingtallation scripts.

Site* Default site code. This should be the FEMIS four letter code for
your site.

EOC* Default EOC code. This should be the FEMIS four letter code for
your site.

DestDir Default installation destination directory for new installations.

Re-installations and upgrades will default to the current FEMIS path.

Version Gives the version of FEMIS for which thisinstance of FSETUP.INI was
created.

DateThisFSETUPCreated Givesthe build date for this version of FEMIS.

mDriveNetPath* Path to the FEMIS M:\ drive that the FEMIS startup script will connect.
This does not need to be set if you use an alternate method to map the
M:\ drive. Enter this specification only if you desire to have fstartup.exe
attach the M:\ resources on the majority of PC installations.

LocalStartupScript Full path for alocal startup script to be run by the FEMIS startup script.
Thisisoptional.

EMIS_StartupScript Full path to the EMIS startup script file. The FEMIS startup script file
will run thisfile.

The second section of the INI file, the [Sites] section, is used to fill the Site drop-down list in the Select
Site and EOC window in the PC Setup program. Y ou can edit thislist to limit the possible selections
availablein Setup. Each site entry must be formatted as SiteNN=<SITECODE> where NN isatwo digit
integer and <SITECODE> all uppercase. If you shorten thelist of sitesto asingle entry, the user will be
forced to accept that entry when running Setup. If you edit the list, the numbering for the sites must be
sequential, starting at 01.

Subsequent sections are lists of EOCsfor each sitein the [Sites] section. Each sitelisted in the [Sites]
section must have a corresponding [<SITECODE> EOCs] section. These sections are used to fill the EOC
drop-down list in the Select Site and EOC window in the PC Setup program when the corresponding site
is selected on the same window. The EOC list sections can be edited in the same manner asthe Sitelist.
Each EOC entry must be formatted as EocNN=<EOCCODE> where NN is a two digit integer and
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<EOCCODE> must be all uppercase. If you shorten thelist of EOCs to a single entry, the user will be
forced to accept that entry when running Setup. If you edit the list, the numbering for the sites must be
sequential, starting at 01. EOC list sectionsthat do not have a corresponding site listed in the [Sites]
section will be ignored.

4.2.3 Verifying the GIS.INI Files on the Server—Maryland Only

The Maryland GIS has one set of INI files (small, medium, and large) for each EOC. Each of the other
sites has one set that isused by all EOCs. Consequently, an extra step is necessary in Maryland to ensure
that the correct set of INI files arein place before installing FEMIS on the PCs.

The /home/femis/gis/sbcc_apr directory on the server iswhere Setup will look for the INI files. This
directory has a subdirectory for each EOC that contains the three INI files. Before running Setup on the
PCs, log onto the server as the user femis and copy the files from the subdirectory for your EOC. For
example, at the MEMA EOC, you would log onto the server and enter the commands

%cd /home/femis/gis/sbcc_apr
%cp /mema/* ./

4.2.4 Validating the 1\CONFIGD\TNSNAMES.ORA File

The TNSNAMES.ORA file should be configured with the correct database names, listeners, and IP
addresses. Thisfile should be a copy of $TNS_ADMIN/TNSNAMES.ORA on the UNIX server. For each
listener on each server, it should contain asection like the following. The partsin Italics are what should
be changed. (See Section 2.3.3.2, Installing the Oracle Software, Step 10 to edit the var/opt/tnsnames.ora
file):

fi_ctoo =
(DESCRIPTION =
(ADDRESS_LIST =
(ADDRESS =
(COMMUNITY = TCP)
(PROTOCOL =TCP)
(HOST = ctoosun.utah.gov)
(PORT =1521)

)

)
(CONNECT_DATA =
(SID =fi_ctoo)
)
)

Note: The setup program will not copy the TNSNAMES.ORA fileto aPC if that PC aready has
aTNSNAMES.ORA file. See Section 15.2, FUPDATE.BAT in the FEMI S System
Administration Guide for more details on how to configure FUPDATE.BAT, if you need
to update the TNSNAMES.ORA file on al of the PCsthat will be running FEMIS.
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4.2.5 Validating the '\CONFIGD\ADDODBC.BAT File

FEMIS uses the \USER\ADDODBC.BAT batch file to add all the necessary ODBC data source names to
each PC. Verify that the mapping from EOC code to listener ID is correct for each line.

If any changes are made to thisfile after FEMIS has been installed on PCs, the I\USER\FUPDATE.BAT
file needs to be updated to propagate the updatesto all PCs.

4.2.6 Validating the I'\CONFIGD\AUTOEXNT.BAT File

During the installation process, the I\CONFIGD\AUTOEXNT.BAT fileis copied to the
%WINDIR%\SYSTEM32 directory, usualy C\WINNT\SYSTEM32. Thisfile should contain the following
commands. The <TEMPLATE_HOSTNAME> should have been changed to the name of the FEMIS
UNIX server.

net stop NetWorkTimeProtocol

%WINDIRY%\SYSTEM32\PING -w 60000 TEMPLATE_HOSTNAME
%WINDIRY\SYSTEM32\NTPDATE -b TEMPLATE_HOSTNAME
net start NetWorkTimeProtocol

The AUTOEXNT.BAT fileisinvoked at boot up. Its purposeisto synchronize time on the PC while
bypassing the usual NTP time adjustment algorithms. NTPDATE immediately sets the time on the PC to
be the same as on the UNIX server. After boot up, the usual NTP agorithms apply.

Note: Besurethat thelast line shown aboveispresent. Thisline may be deleted by the UNIX
setup script that configures the file with the UNIX server name.

4.2.7 Validating the '\CONFIGD\NTP.CONF File

During the installation process, the NTP.CONF fileis copied to the %WINDIR% directory, usually
C:\WINNT.

The NTP configuration file on the PC should contain at a minimum one drift file and one-or-more server
directives. Theformat of the drift file directive is driftfile %WINDIR%\NTP.DRIFT, where %WINDIR%
usually is C:\WINNT.

The format of the server directive is server <hostname>, where hostname is the name of the UNIX server
from which the PC isto acquire time synchronization. Generally, thisisthe UNIX computer located on
the same Local Area Network (LAN) asthe PC. PCs should acquire time synchronization first from the
closest UNIX computer and not from some distant host on the WAN or the Internet. Distant hosts can be
used as a secondary time synchronization source. To designate the primary NTP host, include the
keyword, prefer, in the server directive.
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As an example, the following NTP.CONF fileisthe preferred format for NTP configuration. It liststhe
local UNIX server asthe preferred time server and the other (far away) servers as secondary. Inthis
manner, if the preferred host is inaccessible, one of the secondary servers can provide time
synchronization:

server <IP address of UNIX server> prefer
server <IP addresses of other servers on WAN>
server <IP address of server on the Internet>
driftfile CAWINNT\NTP.DRIFT

The Network Time Protocol serviceis very sensitive to the format of thisfile. Occasionaly, in
transferring this file from between UNIX and Windows computers, extra carriage return characters will
be appended to the end of each linein thisfile. These extra characters are not detectablein a PC editor,
but show up as “~M” characters at the end of each linein aUNIX editor, such asVI. These extra
characters at the end of aline with a server directive will prevent the Network Time Protocol service from
loading correctly. If the Network Time Protocol service does not appear to be working, this should be
checked.

For more details on NTP set up and configuration methods, see Section 11.0, Server Network Time
Protocol (NTP) Set Up, inthe FEMI S System Administration Guide.

4.2.8 Validating the I'\USER Directory

Verify the following files are located in I\USER directory. FEMIS uses these filesto create the ODBC
Data Source Names (DSNs) that are used to connect to the Oracle relational database. Thesefilesare aso
used to update files on each PC as needed (see Section 15.2, FUPDATE.BAT in the FEMI S System
Administration Guide for more details on how to configure FUPDATE.BAT).

» ADDODBC.BAT
» FUPDATE.BAT
» ODBCSUB.VBS
» PFEMIS.VBS

4.2.9 Configuring the I\PC\FEMTOOLS\FEMIS.DB File

To configure the servers and routers to match your network configuration, you will need the server names
for dl EOCs at the site. If you have not previously configured a femis.db file, it will not exist. Your PC
needs to be able to resolve the host names of al the servers on the network either through a naming
service or HOSTS file.

1. Execute atelnet session to the FEMIS server by clicking Start - Run, and enter telnet <server>.
Logon using the femis account.
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10.

Change the Permissions on the /home/femis/pc/femtools directory and the femis.db file (if it exists)
by entering the following:

chmod 775 /home/femis/pc/femtools
chmod 777 /home/femis/pc/femtools/femis.db

Do not close the telnet session window.
Note: If the FEMIS.DB file' s attributes are set to read-only, then WS_WATCH.EXE will not be

able to save the new configuration you create, but it will not give any indication of an
error.

Run I\PC\FEMTOOLS\WS_WATCH on the PC.

Select File & Load, browseto I\PC\FEMTOOLS, select FEMIS.DB, and click Open. |f FEMIS.DB
does not exist, click Cancel.

If the FEMIS.DB you opened does not resemble your network architecture, close WS_WATCH.EXE,
delete \PC\FEMTOOLS\FEMIS.DB, and restart WS_WATCH.EXE.

Select Edit menu item and modify the grid to match your network. To add a system, select
Add = Host. Aniconwill display. Position the icon where you want it.

Click once on the new host, and the host information window displays. Enter the following
information.

Display Name: <server name>
Address/Name: <server name>
System Type: <server or router>
Type: TCP/IP

Click Accept.
Note: Repeat Steps 2 through 4 for all FEMIS servers, network routers, and other systems
significant to the network at your location. Usethe Edit > Add = Line to show

appropriate network connections between items.

Add lines between hosts to resemble network connections by selecting Add = Line and right click on
the beginning and end of the line position.

Delete hosts or lines by selecting Delete - Host/Line. Left click on the host to delete. Right click on
theline to delete.

Select END_EDIT, File > Save As. Savethefile as \PC\FEMTOOLS\FEMIS.DB. If it isnot saved
with this name and location, it will not be installed on the PC during setup.
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11. ExitWS_WATCHE.EXE.

12. Return to the telnet session to the FEMIS server. Change the Permissions on the
/home/femis/pc/femtools directory and the FEMIS.DB file located there by entering the following:

chmod 555 /home/femis/pc/femtools
chmod 444 /home/femis/pc/femtools/femis.db
exit

13. Close the telnet window.

4.2.10 Updating Files on All PCs Using FUPDATE.BAT

FUPDATE.BAT isautility that can be used to update any file(s) on al FEMIS PCs such asthe HOSTS
file or GIS datafiles. View the M:\\FUPDATE.BAT fileitself for specific instructions on how to configure
it to update files on all FEMIS PCs.

When updating GISfiles, it is necessary to know the path where the GIS was installed and sometimes the
size of the GIS that was installed. These can be determined by adding the following line to
FUPDATE.BAT.

call %FemisTopDir%\GIS\<site_code> ENV.BAT
Thiswill set two environment variable:

GisTopDir —Thisisthe top level directory for the GIS data. For example, it might be
C:\FEMIS\GIS\DCD1 if you were in DCD1 and had installed the GIS on your C:\ drive. This
environment variable can be useful for sites where people install the GIS on different drives.

GisSize — This environment variable will contain the relative size of the GIS (SMALL, MEDIUM, or
LARGE). Thisenvironment variable can be useful if you need to update the FEMISGIS.INI filesfor a
site where not everyone installed the same size GIS data.

See Section 15.2, FUPDATE.BAT inthe FEMI S System Administration Guide for more details on how
to configure FUPDATE.BAT.

4.2.11 Updating the PC HOSTS File

Depending on the DNS and TCP/IP configurations for the local PCs, it may be necessary or desirable to
update the HOSTS file on PCs as part of the FEMIS installation. If the PC does not have aHOSTS file
and one has been configured on the installation server in the /homeffemis/configd directory, the PC Setup
program will copy that file to the PC. However, if aHOSTS file aready exists on the PC, the PC Setup
program will not overwrite it.
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If it is decided to update the HOSTS file on all PCs, the update should be done using the FEMIS
FUPDATE tool. The FUPDATE tool isrun as part of the PC Setup program, so updates will beinstalled
when FEMISisinstalled. FUPDATE isalso run each time a user logs into a PC, so updates, that are
configured after one or more PCs have been installed, will ill be copied to those PCs.

Note: The setup program will not copy the HOSTS file to a PC if that PC already hasaHOSTS
file. See Section 4.2.10, Updating Files on All PCs Using FUPDATE.BAT, if you need
to update the HOSTS file on all of the PCs that will be running FEMIS.

4.3 Installing the FEMIS Client Software

This software is for the PC workstations that are connected to the FEMIS data server and contains the
FEMIS client software and a collection of GIS themefiles. The installation program for the FEMIS client
software assumes the necessary COT S packages have already been installed.

The FEMIS client software isinstalled over the network from a UNIX server. The client software
contains over 120 files representing approximately SOMB of file space.

The FEMIS executable and other FEMIS support files will be loaded to the following locations:

e current %WINDIR% directory, usualy C\WINNT
*  %WINDIR%\SYSTEM32 directory

e C:\FEMIS directory

*  Microsoft Project directory.

All files needed by the installation process should have previously been copied from the rel ease tape or
CD to the server. Thefiles specified in Section 4.2, Configuring the FEMIS Setup Program, should have
been configured or validated before the FEMIS client software is installed.

4.3.1 Preparation
To prepare for starting to install FEMIS v1.4.7, complete the following steps:

1. LogintoWindows NT as Administrator or to a Windows NT account that has Administrator
privileges. Setup will abort if it isrun from a Windows NT account that does not have Administrator
privileges.

2. Veify that al COTS needed by FEMIS are installed on the PC. At the minimum, the following
should be installed (the Setup program will also verify that these areinstalled). Y ou should also
consult the FEMI S Bill of Materials (BOM) and verify that the correct versions of the software
products are installed.
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e Microsoft Windows NT
e Oracle Net8

* Oracle ODBC Driver

* ArcView GIS (ESRI)

Note: FEMIS also requires software to allow the PC to map directories on the FEMIS server to
logical driveson the PC. If Sambais being used, no additional softwareis required on

the PC. If an NFS software package such as Hummingbird Maestro or Sun Solstice NFS
Client is being used, then the client software needsto beinstalled on the PC.

4.3.2 Running the Setup Program
The FEMIS Oracle database on the UNIX server must be operational before the setup programis run.
1. Closeall programsthat are running, especially all FEMIS programs, including KeyPrint.

2. Connect your I:\ drive as specified in Section 4.2.1, Connecting the Network Install Drive, if you have
not already done this.

3. Runthe \PC\SETUP\SETUP.EXE program. The setup will bring up severa windows that require
your response.

Select Site and EOC: This alows you to select the Site and EOC from drop-down lists. The
contents of the lists are controlled by the I\PC\SETUP\FSETUP.INI
file.

Select Components: This alows you to select which FEMIS components will be installed.

The GIS and Additional Ilcons components have options that are
accessed by highlighting the component and clicking the Change
button.

Select Program Folder: This alows you to specify which folder in the Start menu will be used
for the FEMISicons. The default isFEMIS.

Choose Destination Location: This alows you to specify the drive and directory where FEMIS will
beinstaled. If FEMIS has previoudy been installed on the PC, the
default isthe last place where FEMIS was installed. If thisisthe first
time FEMIS has been installed on the PC, the default location is
C:\FEMIS.
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4.

5.

GIS Data Path: Thisalows you to select a destination for the GISfiles. The default
location is C:\FEMIS\GIS\<site code>.

Note: You may seeimproved performance from the FEMIS GIS if you choose to install the
GIS on a separate physical disk than the one on which you are installing FEMIS.

Start Copying Files: This displays an information window showing the options that have
been selected. Select Next to begin copying files.

The next part of the Setup program will take several minutesto configure the PC. Y ou may receive
prompts or setup may wait for confirmation before performing some items. Watch and click OK or
press Enter, as needed. These configuration operations will

* Update the FEMIS.INI for the PC name, FEMIS and GIS directories, and COTS paths.
*  Open ArcView to convert the FEMISGIS.INI fileto v1.4.7 format (if applicable).
* Open ArcView to regenerate the FEMISGIS.APR file.

Note: Whenthe FEMISGIS.APR is generated, the system checksto seeif any private GIS
ViewMarks exist in the VIEWMARK.ODB filein the
M:\[SITECODE\[USERCODENGIS\VIEWMARKS directory. If afileexidts, itisassumed
valid and will be used so that no old ViewMarks are lost. If no VIEWMARK.ODB file
exigts, anew file is generated with only one default ViewMark. This same check process
is repeated for the shared ViewMarks.

* Add ODBC information for the FEMIS databases.

»  Start the NTP service to synchronize time on the PC with the server.

e Create the C:\WINNT\SYSTEM32\AUTOEXNT.BAT file.

e Set the system to use FEMIS's own GLOBAL.MPT file with Microsoft Project.
* Remove obsolete files from older FEMIS installations.

* Verify the required COTS packages are installed.

* Add FEMIS environment variables, if needed.

Select Yes, | want to restart my computer now. on the Setup Complete window. Click Finish.

Log back in as Administrator after the computer restarts.

4.3.3 Updating the FEMISGIS.INI File

If the GIS Upgrade option was selected, perform the following steps after the PC has been rebooted.
Otherwise, proceed to Section 4.3.4, Regenerating the FEMIS GIS Dynamic Themes.

1

Map the I\ drive on the PC to the /home/femis directory on the server. Connect to the drive as the
user femis.
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2. Openthe FEMISGIS_UTILITIES.APR in ArcView GISv3.1.1.

3. Select Check INI Themes from the Utilities menu. A file dialog box displays. Find the <PC FEMIS
GIS DIRECTORY>\<SITECODE>\FEMISGIS.INI file and click OK.

Thiswill create a message box and error log file of missing themes from the FEMISGIS.INI filesin
thelocal GISdirectory. See Section 3.1.5, Troubleshooting the Migration, if there are any missing
themes reported.

4. Click OK.
A message box will display reporting any duplicate theme names or theme legend names in the
FEMISGIS.INI file. If there are duplicate theme and/or legend names, open atext editor and change

the theme name and/or legend name to a unique name. Save the file and repeat Step 3 of above.

5. Closethe FEMISGIS_UTILITIES.APR.

4.3.4 Regenerating the FEMIS GIS Dynamic Themes

The FEMIS GIS has both static and dynamic themes. The Setup program installs the files for the static
themes. Thefilesfor the dynamic themes are generated by the FEMIS application from data stored in the
FEMISrelational database. These dynamic theme files need to be regenerated after installing (or
reinstalling) FEMIS on a PC.

To regenerate the dynamic GIS themes, complete the following steps:

1. Stat FEMISandlogin.

2. Click the Map button on the FEMIS Workbench to start the GIS, and wait for the GIS to load.

3. Click Utility on the menu bar, and select Regenerate Map Layers - Regenerate Point Map Layers.

4. Click the Utility on the menu bar, and select Regenerate Map Layers - Regenerate Polygon Map
Layers.

4.4 Configuring the PC

4.4.1 Setting Up FEMIS User Accounts on Windows NT and UNIX

For Windows NT to be able to connect to the required FEMIS drives |ocated on the FEMIS server, a

UNIX user account on the FEMIS server must be created for each Windows NT user account that will be
used to run FEMIS. Each of these UNIX user accounts must have the same username and password as its
corresponding Windows NT user account. These are separate from the usernames and passwords that are
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used to log into the FEMIS application. The usernames and passwords used to log into the FEMIS
application do not need to match the UNIX or Windows NT usernames and passwords.

Note: Both of the Windows NT and UNIX user accounts must have the same username and
password so that network drives can connect correctly. Windows NT and UNIX
usernames and passwords ar e case sensitive. For example: JSmith and jsmith will not
work.

You can set up individual user accounts (such as jsmith) on one or on al of the PCs and the FEMIS
server. Positional accounts (such as sheriff) can be set up on one or all of the PCs and the FEMIS server.
One global (such as femisuser) can be set up on all of the PCs and the FEMIS server, or some other
combination.

Note: Setting up and maintaining individua or positional accounts on al of the PCs and the
FEMIS server can be time consuming, especially if you have many accounts and many
PCs. If the password is changed for an account on one PC, it must be changed on all the
others so they can all still connect to the network drives correctly.

4.4.1.1 Adding User Accounts to Windows NT

To add aWindows NT user account on aWindows NT PC, log onto the system with an account with
Administrator privileges and complete the following steps.

1. Click Start > Program - Administrative Tools - User.
2. Select New User, and fill in the following fields on the User Manager window:

Username:

Full Name:
Description:
Password:

Confirm Password:

3. Check with your System Administrator to determine which of the following options should be
checked.

User must change Password at Next Logon
User cannot change Password

Password never expires

Account disabled

After creating the Windows NT account, verify the following two items.

»  The username and password entered are the same as those for this user on the UNIX server.
*  TheWindows NT account is at least in the Users group under the Groups button.
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4.4.1.2 Adding User Accounts to UNIX

Refer to Section 2.1.1.3, Creating Users and Groups, for instructions on adding usersto the UNIX server.

4.4.2 Running the FEMIS Startup Files

FEMIS requires that several network drives be connected in order for all itemsto work correctly.
Running the FSTARTUP.EXE program connects these drives, and this program should be run
automatically when a user logs into Windows NT. Depending on how your network and PCs are set up,
use one of the two methods listed below for the program to run automatically.

Note: Most sites should use Method 1 and only add the Windows NT user accounts that will
actually be running FEMIS and have corresponding accounts on the UNIX server.

If both FEMIS and EMIS are being installed on asingle Windows NT account, you will need
to edit the FEMIS.INI file. See Section 4.2.2, Validating I'\CONFIGD\FSETUP.INI File, for
details. This should be done once on the UNIX server before FEMIS isinstalled on the PCs.

Method 1: As a User Login Script

1. When the Setup program completes, select User Manager in Administrative Tools in the Program
Manager or Start menu.

2. For every Windows NT user account that will run FEMIS, select the user in thelist. Then select the
menu item Properties under User, and click the Profile button on the form that appears. If you use an
NT domain to manage user accounts, this should be done on the domain server. Otherwise, this
should be done on each PC that is used for FEMIS.

3. Inthe Logon Script Name field, enter FSTARTUP.EXE.
Method 2: In Startup Folder

1. Using Windows NT Explorer, open the C:\WINNT\PROFILES\ALL USERS\START
MENU\PROGRAMS\STARTUP folder. From the File menu, select New - Shortcut, and a Create
Shortcut dialog box displays. At the Command Line, enter
%WINDIR%\SYSTEM32\REPL\IMPORT\SCRIPTS\FSTARTUP.EXE, and click Next. Enter aname
for the shortcut, such as FEMIS Startup Script.

2. Follow the steps later to verify that the icon isin the common Startup folder instead of a personal
Startup folder.

See Section 4.2.2, Validating I'\CONFIGD\FSETUP.INI File if you wish to customize the startup. You

can specify additional drives to be mapped by the FEMIS startup script, and specify local startup scripts
to be run after the drives have been mapped.
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4.4.3 Verifying the Temporary Directory and Environment Variables

The GIS and other programs need a directory to store temporary files. Use the following steps to verify
that this process was completed correctly by the Setup program.

1

2.

5.

Click Start - Settings = Control Panel = System.
Select Environment.

Verify thereisaUser Variable named TEMP (usually C\TEMP). If not, enter TEMP in the Variable
field and C:\TEMP in the Value field. Click Set.

Verify that a FEMISTOPDIR environment variable exists in the System Variables box. If not, select
it and change the value in the Variable and Value text boxes, and click Set. The value of this variable
should be set to the directory in which FEMIS was installed.

If you change anything, you must log out of Windows NT and login again for the changesto take
effect.

Click OK to exit the System Configuration in the Control Panel.

4.4.4 Verifying the Clock Settings and Time Zone Settings

To set the date format preferences so that FEMIS can process the date correctly, compl ete the following
steps.

1.

2.

3.

6.

Click Start - Settings - Control Panel - Regional Settings.

Select the Date tab in the Regional Settings window.

Set your short date style to dd-MMM-yy (Day - Month - Y ear).

Select the Time tab in the Regiona Settings window.

Verify that you are either using a 24-hour clock (upper case “H” in the Time Style field) or a 12-hour
clock (lower case “h” in the Time Style field) set with the AM and PM symbols are set to AM and PM

(not case sensitive).

Verify the time zoneis correct in the Control Panel = Date/Time icon = Time Zone tab.

4.4.5 Verifying the Time Synchronization Services

To verify the time synchronization services, the files and services discussed in the following sections
should be verified.
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4.45.1 Verifying the AUTOEXNT.BAT File

The AUTOEXNT.BAT fileislocated in the %WINDIR%\SYSTEM32 directory, usually
C:\WINNT\SYSTEM32. Thisfile should contain the following commands.

net stop NetWorkTimeProtocol

%WINDIRY\SYSTEM32\PING —w 60000 TEMPLATE_HOSTNAME
%WINDIRY\SYSTEM32\NTPDATE -b TEMPLATE_HOSTNAME
net start NetWorkTimeProtocol

The AUTOEXNT.BAT fileisinvoked at boot up. Its purposeisto synchronize time on the PC while
bypassing the usual NTP time adjustment algorithms. NTPDATE immediately sets the time on the PC to
be the same as on the UNIX server. After boot up, the usual NTP agorithms apply.
Note: The batch file AUTOEXNT.BAT starts the Network Time Protocol service. Network
Time Protocol should not be started automatically by the control panel. See

Sections 4.4.5.2, Verify AutoEXNT Service and 4.6.3.4 Verify Network Time Protocol
(NTP) Service.

4.45.2 Verify the AutoEXNT Service

To verify that the AutoEXNT service was installed and configured correctly, complete the following steps:

1. Click Start & Settings = Control Panel - Services.

2. Select AutoEXNT. The Status should be blank, and the Startup should be Automatic.

3. Click Startup. Verify the radio buttons for Automatic, under Startup Type, and System Account,
under Log On As, are selected. Also verify the checkbox to Allow Service to Interact with Desktop is
checked.

4. Select Network Time Protocol. The Status should be Started, and the Startup should be Manual.

5. Click Close to return to the Control Panel window.

4.4.6 Verifying the Virtual Memory Setting

For FEMISto run as efficiently as possible, the computer should be set to have at least 250M B
(megabytes) of virtual memory. To check the virtua memory setting and increase it, if necessary,
complete the following steps while logged in as Administrator.

1. Click Start - Settings = Control Panel > System.

2. Select the Performance tab.
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3. Click Change.
4. Increase the Maximum size to 250MB, if necessary, click Set.

5. Click OK, click Close, and select Yes to reboot, if prompted.

4.4.7 Creating FEMIS Icons
The FEMIS Setup program creates a shortcut on the All Users’ desktop to the FEMIS folder on the Start
menu. If you wish to add more shortcuts to the FEMIS folder on the Windows Start menu, you can

simply add the shortcuts to the FEMIS folder on the desktop.

If you wish to have any of the FEMIS icons on the desktop, copy the shortcuts from the FEMIS menu on
the desktop to the C:\WINNT\PROFILES\ALL USERS\DESKTOP folder.

If you with to delete any of the shortcuts, right click on the shortcut to be deleted and select the Delete
option. Thiswill only delete the shortcut, not the program to which it points.

Note: If anicon or ashortcut is not created in the All Users profile, the FEMIS icon will only
show up for the user under whose profile the shortcut was created.

4.4.8 Final Steps for the FEMIS PC Installation and Configuration

Note: If thisisan upgrade installation, you may wish to clean up old icons from the Program
Manager. These may include old icons for the FEMIS program and old icons for running
the startup batch filesin the Startup group.

The following are the final steps for the FEMIS installation.

1. Logout of Windows NT.

2. Loginto Windows NT asthe appropriate user account. Run FEMIS.

3. Veify theinstallation of the first PC thoroughly by following Section 4.6, Validating the FEMIS PC
Installation, before any more PC installations are started. If you must edit any of the configured files

(e.g., ADDODBC.BAT, TNSNAMES.ORA), copy the corrected file back to the server and install again
to be sure that it will work correctly.

4.5 Configuring FEMIS for All PCs at an EOC

The following validation steps need to be performed one time at each EOC. Since these configuration
changes affect values stored in the FEMIS database for the EOC, they will take effect on al of the PCs
using the same database.
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4.5.1 Verifying the Zone Name Lookup for EMIS PAR

Note: If both of the following two conditions are true, you must complete this section:
1. You are currently installing FEMIS on an onpost PC.
2. EMISisused onpost at your site.

Y ou can skip this section if you are upgrading from an earlier version of FEMIS, and you
performed these steps when that version was installed.

Because EMIS allows users to change zone names at will, thereis a possibility that FEMIS and EMIS
zone names will not match exactly. It isimportant, however, for FEMIS to be able to map its zone names
to the zone names used in EMIS so that Protective Action Recommendations (PARS) may be shared
between the systems. For this reason, asimple utility named FZONES.EXE has been added to the list of
system administration software tools available on the PC. Thistool allows your FEMIS System
Administrator to set up the EMIS zone name aliases so FEMIS will be able to correctly map PAR
information sent from EMIS. If EMISis part of the site configuration, then this utility must be run on the
onpost FEMIS at installation and again whenever EMIS changes their zone names.

4.5.2 Using FZONES.EXE Tool

FZONES.EXE isasystem tool that runs on the PC. Before you can run thistool, you will need to install
at least one PC with system tools.

Thistool displays a two-column spreadsheet of zone information. In thefirst column, thereis aread-only
list of FEMIS zone names. In the second column, there is awritable copy of the EMIS zone names.
When you first start this utility, it will load the values currently in the database for the FEMIS and EMIS
zone names. If at any time during the editing process you wish to rel oad the spreadsheet based on the
valuesin the database, click the Reset Spreadsheet button.

To populate the FEMIS/EMIS zone lookup table, you will need to get alist of all the EMIS zone names
for thesite. Thisinformation may be found on the EMIS server in the following file:
/<disk>/emis3run/emisdyn/data/<site code>/emisgis/giszne.dat. The <disk> and <site code> will be site
specific. Once you have the EMISist of zones, the smplest way to popul ate the lookup tableisto run
the FZONES utility, and then type the EMIS zone names directly in the spreadsheet next to the
corresponding FEMIS zone name. When the spreadsheet is complete, click the Save button.

4.6 Validating the FEMIS PC Installation

To run correctly, FEMIS software relies on many integrated components: the FEMIS database,
commercial and government supplied software products, the FEMIS application, and system support
services. Therefore, it isimportant to ensure that the FEMIS system is fully operational. This section
will assist your System Administrator to validate that the FEMIS system has been properly installed and
is operating correctly.
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The FEMIS PC Validation Checklist, provided at the end of this section, includes items that need to be
checked to ensure that the FEMIS system is operating properly. The Checklist correlatesto the items
listed below. These items are tested from the PC to ensure access and integration into the FEMIS
application. This checklist provides a method to validate that the server and external communications are
properly installed.

If problems are encountered during the validation, refer to Section 16.0, FEMIS Application Error

Messages and Troubleshooting, in the FEMIS System Administration Guide for suggestions and
guidance.

4.6.1 One Time at EACH EOC
The following validation steps must be performed one time at each EOC.
4.6.1.1 Verify Default D2PC Case Exists

From the FEMIS Workbench or the Tracking Navigator, click D2PC. On the D2PC Interface window,
select Edit mode, and click File - Site Defaults = Revert to Site Defaults.

If amessage displays stating there is“no current D2PC case selected” or “no site defaults yet assigned
for this site”, then you will need to create a site default D2PC case.

STOP
If thereisnot a site default D2PC case, select a case that runs and make it the default case.

It isimperativethat you consult with the Hazard Analyst to make sure the new default caseis
modified to meet their needs and saved.

Oncethe EOC has a default case, repeat thisverification step.

4.6.1.2 Verify the Evacuation Command Server
To verify the Evacuation Command server isworking properly, you will need to import and run an
Evacuation case. Evacuation cases are located on the I:\data\evac directory where I\ is\\<server

name>\home/femis. Seethe FEMIS Help for guidance on importing and running acase. Make it your
current operational case (on the Evac main window, File > Make Case Current Operational).

4.6.1.3 Verify FEMIS/EMIS Data Exchange Interface (DEI)

Note: The definitive description of thisinterface can be found in Section 7.0, FEMIS Data
Exchange Interface (DEI), in the FEMI S System Administration Guide.
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To verify that DEI is operating, click the Status menu in Operations mode and the select Met Condition.
If the current meteorological (Met) data appearsin the table, then the DEI is probably running.

4.6.1.4 Create a Plan for Validation Testing

To create a planning dataset that is shared so it can be used for PC validation, complete the following
steps:

1. Click on Utiltiy = Planning Functions <> Planning.

2. Choose Create New Shared Dataset from the Dataset drop-down list.

3. Name the new dataset, and click OK. The Tracking Navigator displays.
4. Click on Plan > Select Plan.

5. Select Basic Template from the Select Plan spreadsheet, and click Select.
6. Click the New Data button.

From the Tracking Navigator, you will need to create a Protective Action Decision (PAD) and a
Community Condition as part of this validation test.

Complete the following stepsto create a PAD for the validation test.

1. Click onthe PAD function box and OK to the message box that displays.

2. Select the Edit radio button.

3. Create anew PAD by entering a name in the PAD Name field, and click OK.

4. Click the New Data button.

Compl ete the following steps to create a Community Condition for the validation test.
1. Click on the Community Function box and OK to the message box that displays.
2. Select the Edit radio button.

3. Create anew Community Condition by selecting Default from the Name drop-down list, renameit,
and click OK to create a new Community Condition.

4. Click the New Data button.
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Complete the following steps to create a VValidation plan.

1

2.

3.

4.

5.

5.

6.

Click on Plan = Copy Current Plan.

Enter aname for the new plan, and click OK.

Click on Plan - Select Plan

Click No to AutoCalc synchronization message that displays.
Select the plan name created in Step 2, and click Select.
Click the New Data button.

Click on Edit under Tasks, and click OK on the message box. Microsoft Project is displayed.

Complete the following steps to add atask in Microsoft Project.

1

2.

3.

5.

6.

Click on an empty row.
Click on the Task Details Form button (far left side of the toolbar).

Select items from the Agency and Stage drop-down lists, select the Times & Misc tab. Click Save to
save the task changes. Click Close on FEMIS Task Details.

Click on Save under Tasks on the Tracking Navigator to save this plan, which will be used to Verify
Electronic Planning (item 15 on the FEMIS PC Validation Checklist).

Click the New Data button.

Click on Exit Project under Tasks and click Y es on message window.

4.6.1.5 Testthe GIS on the Printer

Not al printers display graphics the same. For each printer to which you anticipate printing, use both
KeyPrint and the Print option on ArcView GISto print a GIS map that contains a D2PC case, Threat
Area, Risk Areaand one or more facilities under each. Review the printout to ensure that it prints
graphicsin such away that:

Risk and No Risk can be differentiated.

One feature does not totally obscure an underlying feature (e.g., Y ou can still see facilities located in
the Threat Area, and the Threat Area does not wipe out the D2PC isopleths.).
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4.6.1.6 Verify E-mail

Verify E-mail can be sent to usersin al other EOCs.

4.6.1.7 Verify the SEPR Icon Addressee

Verify the addressee in the SEPR (Software Enhancement/Problem Report) icon fileisthe desired

addressee for that EOC. Some EOCs want to compile/review the SEPRs before they send them to PNNL.

Check the palicy of the EOC and modify the SEPR template as needed. If they want it to go directly to

PNNL, use ranata.johnson@pnl.gov (Ranata Johnson’'s E-mail address) or blanche.wood@pnl.gov
(Blanche Wood' s E-mail address).

4.6.2 Cleanup AFTER Validation

Note: Do not perform thefollowing clean up procedures until completing the validation
stepsin Section 4.6.3, Perform on EVERY PC.

After completing the above validations steps, the following cleanup validation steps need to be performed
onetime at an EOC, not on every PC.

4.6.2.1 Delete Validation Datasets

Delete the planning dataset created for validation in Section 4.6.1.4, Create a Plan for Validation Testing,
aswell as any other planning datasets that were created for the purpose of installation or validation.

4.6.2.2 Ensure Exercise #1 Exists

Ensure Exercise #1, or whatever Exercise is recognized by EMIS has been created. Thiswill allow EMIS
to communicate with FEMIS in Exercise mode.

4.6.2.3 Remove Extraneous FEMIS User Accounts
Remove extraneous FEMIS user accounts that were created during installation and validation. Be sureto

leave the one user account, authorized by your System Administrator that will be used during the
Shakedown Test.

4.6.3 Perform on EVERY PC

The following validation steps should be performed on every PC.

Note: LogintoWindowsNT with Administrator privileges.
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4.6.3.1 Ensure FEMIS Login Security

If the PC has afemis account under Windows NT, make sure that the password is not set to femis.

4.6.3.2 Verify the PC Configuration

Verify each of the following items to make sure the PC’ s configuration is correct.

Icons |eft from previous installations of FEMIS but are no longer linked to a program should be
removed from the Start > Programs - Femis folder.

* KeyPrintisinthe Startup group for all users.
e Virtua memory maximum sizeis set to at least 250MB.
 TheFEMIS startup fileis caled either in each user’s profile or from the All User Startup folder.

e System Environment variable FEMISTOPDIR is defined and set to the directory where FEMIS is
installed.

4.6.3.3 Verify the PC Clock

Verify the PC clock by clicking Start - Settings = Control Panel-> Regional Settings. On the Date tab,
verify your date style is dd-MMM-yy (Day - Month - Year). On the Time tab, make sure you are using
either are a 24-hour clock (upper case “H” in the Time Style field) or a 12-hour clock (lower case “h” in
the Time Style field) with the AM and PM symbol fields set to AM and PM (not case sensitive).

4.6.3.4 Verify the Network Time Protocol (NTP) Service

To verify the Network Time Protocol (NTP) will synchronize with the server for small variationsin time
when the PC is booted up, complete the following steps:

e Click Start - Programs - Administrative Tools - Event Viewer to the Event View window. Under
the Log menu item, select Application. Check for warning or error messages (yellow or red icon) with
NTP asthe source. Troubleshoot as necessary.

» Verify the Network Time Protocol startup is set to Manual.

* Verify thefifth line of CAWINNT\SYSTEM32\AUTOEXNT.BAT has been changed to read
NTPDATE -b <hostname>, where <hostname> is the name of your UNIX server.

» Changethe PC clock to asignificantly different time (1 hour or more).
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* Restart the PC (Start » Shut Down - Restart the Computer).

» Login and verify that the PC clock has been reset correctly.

* FromaDOS prompt, enter the command ntptrace. This should return alist of the serversthat are
used to synchronize time to the PC. If this does not happen, see Section 4.2.7, Validating the
I'\CONFIGD\NTP.CONF File for more information on thisfile.

Note: Do not use Administrator privilegesto perform therest of the validation steps.

4.6.3.5 Verify Login

For Windows NT v4.0, check to make sure a shortcut to FEMIS exists.

» Validate the ability to access the FEMIS application by double clicking on the FEMIS icon.

e Confirm that the correct default Site/EOC is highlighted.

* Enter avalid usercode and password. The Select Mode window should display.

» If there are Oracle problems with FEMIS from a particular Windows NT machine, check its path
(Control Panel > System Environmental Variables). If thereisan Oracle directory (i.e.,
S:\EMISDYN\ORANT\BIN) referenced that is not pointing to where FEMIS installed Oracle (either on
the C:\ or D:\ drive), then this portion of the path must be removed. Check with the other software
vendors, as appropriate, to be sure thiswill not cause problems to their software.

* Veify the ability to enter Operations mode.

4.6.3.6 Verify Data Manager

Select Start © Programs - FEMIS - Data Manager to validate the accessto the FEMIS Data

Administration functionality. If theicon isnot available, select Start > Run and enter or browse to

CA\FEMIS\FDATAMGR.EXE.

4.6.3.7 Verify the System Administration Utility

Select Utility & System Utilities = System Admin from the main FEMIS menu bar to validate the access
to the system administration functionality.
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4.6.3.8 Verify D2PC
Complete the following steps to verify D2PC.

» Click D2PC on the Tracking Navigator. Be patient while the initial connection is made to the D2PC
application and the FEMIS database. D2PC should come up with a default case and should be ready
to run. Select Edit mode.

» Verify the Log Runs checkbox is checked and that you are in Edit mode. From the Run menu, select
the Run Model item. Y ou should quickly get a user interface window containing the results of the
D2PC run.

« Savethe D2PC case.

Note: Onpost users may get messages about sending the D2PC case offpost. Click Yes, and
close the D2PC window.

4.6.3.9 Verify Notification Server

On the Tracking Navigator, you should see a blinking icon (New Data button) that |ooks like a package.
A magenta bar on the D2PC Function box should aso appear. This means that FEMIS data notifications
are being sent and passing messages to your PC. Click the New Data button.

4.6.3.10 Verify GIS

Click the Map button from the FEMIS toolbar. The ArcView GIS application should start, and you
should see a base map displayed within an ArcView GIS window.

To check the link between FEMIS and the GIS, select Facilities theme on the left side of the GIS window.
Click the i+ button on the ArcView GIS toolbar; and then click afacility icon on the map. A view-only
facility/resource window should appear.

Do not closethe Gl Sasit will be used in the following steps.

4.6.3.11 Verify Evacuation

If the one-time validation steps have been successfully completed, there should be a current Evacuation
case displayed on the Tracking Navigator. Click the Evacuation Function box on the Tracking Navigator.
If Evacuation has not been previously executed on this PC, you will get a message telling you to create a
network. Under File, select Create Network. It should display on the GIS. If the network was previously
created on this PC, you will not get the message nor need to create the network. Y ou can merely observe
the network is displayed on the GIS.
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4.6.3.12 Verify Electronic Planning (Planning Mode)

To run FEMIS Electronic Planning in the Planning mode, you must have Microsoft Project |oaded on
your PC and a FEMIS Access Database properly attached. To validate this, click on Utility - Planning
Functions... and select the validation dataset created in the one-time steps (see Section 4.6.1.4, Creste a
Plan for Validation Testing,). Examine the Tracking Navigator window to be sure a Plan has been
selected. Click on Edit under Tasks, which is next to the Plan on the FEMIS Tracking Navigator

(Planning) window. Microsoft Project will open and display the selected Plan. If you can do this without
any errors or error messages, and tasks appear in the grid; then the FEMIS Planning software should work

properly.

The Microsoft Project calendar should be set to a 24-hour clock and a 7-day calendar. Select Tools >
Change Working Time. Every day isgray, and the working timeis 12:00 am. to 12:00 am.

4.6.3.13 Verify Help
Click Help to activate the online Help to verify the Help subsystem is working properly.
4.6.3.14 Verify Printer

Verify KeyPrint was enabled at login. Use KeyPrint or the Print Screen button on any FEMIS window
to ensure the PC is properly connected to a printer.

4.6.3.15 Verify E-mail

Select the MAIL button from the FEMIStoolbar. This should bring up your E-mail application. Verify
that you can send an E-mail message to another PC.

4.6.3.16 Verify SEPR Icon
Send atest SEPR message.
4.6.3.17 Verify FEMIS Tools

Verify on aFEMIS PC with System Toolsinstalled. Click on each of the FEMIS Tools (FEMIS
Monitor PC, FEMISMon Watcher, and Network Monitor) to ensure they are operational.
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Machine Name:

Admin Password:

Task Initials | Notes
1 |4.11Installing Windows NT 4.0
2 |4.113Instaling Windows NT Service Pack 5
3 |4.1.2Instaling an NFS System (Maestro and Patch or Solstice)
4 14.1.3Ingtaling Oracle Net8 Client v8.1.5 and ODBC Driver v8.1.5.5
5 |4.14.1Ingtaling ArcView GISv3.1.1
4.1.4.2 Ingtalling ArcView GISv3.1.1 Patch
6 |4.15Installing Microsoft Project 98 Service Release 1
7 |4.16Instaling Other COTS; Site Specific
8 | 4.2 Configuring the FEMIS Setup Program (Once at Each EOC)
9 |4.2.11 Updating the PC HOSTSFile
10 | 4.3Instaling the FEMIS Client Software
11 | 4.4.2 Running the FEMIS Startup Files
12 | 4.4.3 Verifying Temporary Directory and Environment Variables
13 | 4.4.4 Verifying Clock Settings and Time Zone Settings
14 | 4.4.5 Verifying the Time Synchronization Services
15 | 4.4.6 Setting Virtual Memory Setting (Maximum to at least 250)
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PC Name:

Validated using NT Login:

One Time at Each EOC: Initials Notes
1 | Verify Default D2PC Case Exists
2 | Verify the Evacuation Command Server
3 Only on the server with the depot database, Verify FEMIS/EMIS Data
Exchange Interface (DEI)
4 Create a Plan for Validation Testing
5 | Test the GIS on the Printer
6 | Verify E-malil
7 | Verify that SEPR Icon Addressee
Clean Up AFTER Validation:
1 Delete Validation Datasets
2 Ensure Exercise #1 Exists or Whatever Exercise is Recognized by EMIS
3 Remove Extraneous User Accounts
Perform on Every PC:
1 Ensure Windows NT Login FEMIS/FEMIS Does Not Exist
2 | Verify the PC Configuration
3 | Verify the PC Clock
4 | Verify Network Time Protocol (NTP) Service
5 | Verify Link to M:\ Drive
6 | Verify Login
7 | Verify COTS Software
8 | Verify Data Manager
9 [ Verify System Administration
10 | Verify D2PC
11 | Verify Notification Server
12 | Verify GIS
13 | Verify Evacuation
14 | Verify Electronic Planning
15 | Verify Help
16 | Verify Printer
17 | Verify E-Mall Package:
18 | Verify SEPR Icon
19 | Verify colors are 65,536
20 | Verify FEMIS Tools on Appropriate PC(s)
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